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1
INTRODUCTION

The APPLE ][ and IBM PC use completely different
approaches to floppy disk storage. Consequently, an APPLE ][
disk cannot be directly used in an IBM PC and vice versa.
Previously, the only practical method for transferring files between
an APPLE ][ and IBM PC involved slow, complicated serial file
transfer methods.

Apple-Turnover’s specially designed hardware and software
enables your IBM PC to directly read and write APPLE ][ disks.
Now, you can copy files between APPLEDOS 3.3, APPLE CP/M,
and IBM MS-DOS disks easily and quickly.

1.1 Functional Description
Apple-Turnover consists of the following:

e A printed circuit card that fits into an expansion slot inside
your IBM.

e A program disk with software to read, write and format
APPLE disks in your PC.

e Documentation consisting of this User’s Guide, product war-
ranty, software license agreement, and registration card.

Apple-Turnover is intended for the IBM PC, XT and selected
"PC-compatible” computers. It enables these host computers to
directly read, write and format APPLEDOS 3.3 and APPLE CP/M
disks. Consequently, you can easily transfer files from APPLE
disks to IBM disks, and vice versa.

‘Apple-Turnover can be used to copy or transfer any type of
disk file including APPLE text files, APPLESOFT programs,
APPLE integer basic programs, APPLE binary files, MS-DOS
binary and text files, etc.
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NOTE

Apple-Turnover will not transfer files from copy-protected disks.

Text files and various types of datafiles can usually be used on
the other computer ”“as-is” or with minor modifications. An addi-
tional utility program (ATSIFT) is included in the Apple-Turnover
package for making minor file modifications to text files.

Although executable programs can be transferred from one
computer to the other, they will not generally run. There are, how-
ever, important exceptions. For example, many APPLE CP/M
programs will run on the IBM if you install a Z80 coprocessor card.
Since these cards are expensive, you may want to consider the
"8OMATE CP/M Emulator” from Vertex Systems. This software
enables your IBM to directly run most types of CP/M software,
including APPLE CP/M programs.

The Apple-Turnover printed-circuit card provides the hardware
interface that enables your PC to read and write APPLE ][ disks.
The Apple-Turnover software activates the card when required to
read, write or format APPLE disks. The Apple-Turnover card has
no effect on normal operation and can remain permanently installed.

Since the printed-circuit card remains “invisible” during nor-
mal operations, we can discuss the Apple-Turnover’s features in
terms of the supplied software. The main programs supplied are
described in Table 1-1.

These programs are fully-menu driven and easy to use. Each
program contains user-selectable options to help match program
function to your specific needs.

1.2 User Support

If you need help, please refer to the Appendices for a descrip-
tion of our support services and policies. Please note that a signed
registration card must be on file BEFORE we can provide customer
support.



Table 1-1. Apple-Turnover Programs

ATREAD copies files from APPLEDOS 3.3 or APPLE CP/M
disks to MS-DOS disks.

ATWRITE copies files from IBM format, MS-DOS disks to
APPLEDOS 3.3 or APPLE CP/M disks.

ATINIT initializes blank disks for APPLEDOS 3.3 or formats
disks for APPLE CP/M.

ATSIFT modifies MS-DOS text files by adding or removing
linefeeds, stripping the high-bit, etc.

1.3 Documentation Notes

Throughout this documentation, please note the following con-
ventions:
Table 1-2. Notation in This Guide

COMMAND Program commands or user input are shown in
upper-case type.

[Enter] The “Enter” (or Return) key terminates most com-
mands or other user keyboard input.

[F1] Function-key commands are shown in parenthesis.
Pressing the [Enter] key is not required.

Qorq Single-letter commands can be entered in either
upper or lower-case, but are shown in upper-case.

MS-DOS MS-DOS refers to PC-DOS as well.
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2
INSTALLATION

Apple-Turnover installation consists of:

e making sure your computer meets minimum system
requirements (see Section 2.1)

e reading the enclosed software license agreement and product
warranty, and returning your product registration card .,

e installing the printed-circuit card in one of your computer’s
expansion slots

e preparing an Apple-Turnover work disk from the original
program disk, storing the original disk in a safe place
2.1 Minimum Requirements

Please check to make sure that your computer meets the mini-
mum hardware and software requirements outlined in Table 2-1.

Table 2-1. Minimum System Requirements

COMPUTER IBM PC, IBM PC-XT, or selected "PC-compatible”
computer

MEMORY 192 KB minimum of main system memory

DISKS Two floppy disk drives, or one floppy disk drive plus
an "XT-compatible” hard disk system

MS-DOS PC-DOS version 2.xx or the MS-DOS equivalent is
strongly recommended. Under earlier versions, many
important features like filename wildcards, etc. are
not available.

Apple-Turnover will not function properly with some
computers and peripherals. These are listed in the Appendices.



Your Apple-Turnover package should contain the following
components: (1) Apple-Turnover board, (2) auxiliary cable, (3)
program disk, (4) program manual, (5) product warranty, (6) soft-
ware license agreement, (7) registration card, and (8) problem report
form.

Apple-Turnover is sold with a warranty covering materials and
workmanship of the printed-circuit card. Proprietary software is
furnished under the terms of the enclosed license agreement without
express or implied warranty.

Please read the warranty and license agreement. Then, please
sign the enclosed product registration card indicating your
acceptance of the license agreement, and mail the card within 10
days of purchase.

2.2 Installing the Card

This section presents instructions for installing the Apple-
Turnover printed-circuit card in an IBM PC or XT. This approach
will also work for selected PC-compatible computers.

If you have installed non-IBM components in you IBM PC or
XT, have a Compagq, or need additional information, please refer to
Appendix 2.

The Apple-Turnover printed-circuit card is the -electronic
interface that enables your PC to read and write Apple disks. The
Apple-Turnover software will not function unless the card is
installed. Since the card has no effect on ordinary disk function,
you may leave it permanently installed.

Conceptually, the Apple-Turnover card is installed in series
with your existing disk controller card. Figure 2-1 below shows the
original configuration in most computers.

After you install the Apple-Turnover printed circuit card, your
computer configuration will resemble the sketch in Figure 2-2.

If you are installing Apple-Turnover in an IBM PC or XT,
then follow the instructions in the next section. Check the Appendi-
ces for Compaq installation instructions. Contact your dealer or
Vertex Systems for help with installation in other computers.
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Figure 2-2. Configuration After Installing Apple-Turnover



NOTE

The Apple-Turnover card can be installed almost anywhere between
the disk drives and disk controller card. Just make sure that “pin 1’
on the drives, boards and cables (colored stripe) all mate properly.

2.2.1 Procedure

Use the following procedure for installing the board in an
IBM PC or PC-XT oniy:

STEP 1 Gather the following items: the Apple-Turnover card, the
supplied auxiliary cable, and a medium-size, fiat-bladed
screwdriver. A smaller phillips or cross-head screwdriver
is also useful.

STEP 2 Turn off your computer’s main AC power switch and
remove the AC power cord from the electrical socket.
Attempting to install the board while the AC power is on
will damage the board, vour computer, and void vour
warranty.

STEP 3 Remove the computer’s cover to obtain access to the
expansion slots. Refer to your computer operating man-
ual for additional information on removing the cover.

STEP 4 Locate your floppy disk drive controller board.

The controller board is usually plugged into a full-length
slot closest to the power supply box. Look for a card
connected to the floppy disk drives by a wide ribbon
cable.

STEP 5 Note the orientation of the cable attached to the conirol-
ler board. The colored stripe on one edge of the ribbon
cable shows “pin 1”7 and can be used as an aid to
orientation.
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STEP 6

STEP 7

Unplug the ribbon cable attached to your disk-drive con-
troller board by pulling back on the plastic connector.
Gently rock it off the card-edge connector by pulling it
slightly on each side until it’s loose.

Orient the Apple-Turnover card such that you can read
the serial number in the lower left-hand corner. Locate
two different sets of ribbon cable connectors in the top
left area of the board.

(see Figure 2-3) The card-edge connector is labeled "J1.”
The pin connector is labeled “J2” just to the right.

top
|
— 12
|== oo [ vertical pin
l==2 OO
|== 00O = card-edge
front |== oo connector
|l==J1 OO 12
|== 00O
|== OO

Figure 2-3. Cable Connections

Plug the ribbon cable you removed from the disk control-
ler board onto the card-edge connector (J1) of the Apple-
Turnover board. The colored stripe on the ribbon cable
should be oriented towards the top of the card, matching
the number ”2” silk-screened on the Apple-Turnover
board.

Take the cable provided with Apple-Turnover and locate
the colored stripe (pin 1) on the edge of cable. On the
Apple-Turnover board, locate the gold pin connector (J2).
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STEP 8

STEP 9

STEP 10

STEP 11

Carefully plug the female pin connector on the supplied
ribbon cable into the male pin connector on the board.
The colored stripe on the ribbon cable should be oriented
towards the top of the board, matching the orientation of
the original disk drive cable.

Locate a free expansion slot. If the original metal
bracket cover is still in place, use a screwdriver to remove
bracket retaining screw. Then, remove the metal bracket
that covers the cut out in the back panel of the computer
chassis. Save the retaining screw.

Position the Apple-Turnover card over the expansion slot
so that the metal bracket will slip behind the cut out in
the back panel. Lower the card until it rests on the slot.

Keeping the card level, use even pressure on the back and
front of the card to press it straight down.

The metal bracket on the Apple-Turnover board should
be flush against the back of the computer chassis. Use
the retaining screw you removed earlier to secure the
metal bracket to the chassis.

Take the ribbon cable coming from your Apple-Turnover
board and plug it into the disk controller card. Don’t
forget to make sure the cable stripe is up.

All the cables should be plugged in. If you have one
loose, go back to the beginning of this section and retrace
the steps for installation.

Replace the case on the computer. This completes the
printed-circuit board installation.

2.2.2 Problems

If your disk drive(s) stay on when you power up your
computer, one of the ribbon cables (either the newly supplied cable
or your original disk drive cable) has been installed upside down on
the Apple-Turnover board.
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This will not harm your drives or controller. To restore nor-
mal operation, turn off the AC power to your computer, check the
cables for a reversed cable, and correct the situation.

2.3 Software Installation

Software installation consists of “backing-up” the Apple-
Turnover programs and installing all or a portion of MS-DOS.
Please note that there are two different procedures. Section 2.3.1
presents the procedure for a PC with floppy disk drives. Section
2.3.2 presents a different procedure for an IBM XT or a PC with an
"XT compatible” hard disks.

The Apple-Turnover programs are provided on an IBM for-
mat, MS-DOS disk. The disk is not copy-protected. However, the
disk or individual disk files should be copied only in accordance
with the license agreement.

2.3.1 PC Installation

This section describes the installation procedures for a PC
with floppy-disk drives. Use the process described below to produce
an Apple-Turnover work disk. Store the original Apple-Turnover
program disk in a safe place.

Use the following procedure to prepare a work disk from the
original program disk:
1. Place a write-protect tab on the original Apple-Turnover
program disk.

2. Insert your MS-DOS system master disk in Drive A and boot
your computer using your normal startup procedure.

3. Insert a blank disk into Drive B.
4.  Enter the command: FORMAT B:/S [Enter]

5. When the formatting operation is completed, remove the sys-
tem master disk from Drive A and insert the Apple-Turnover
disk.
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Issue the command: COPY A:*.* B: [Enter]

After all files have been copied from the Apple-Turnover
program disk to your new work disk, remove the program
disk from Drive A and store it in a safe place.

2.3.2 XT Installation

If vou are using a hard disk computer similar to an IBM XT,

then use the following procedure:

1.

Place a write-protect tab on the original Apple-Turnover
program disk.

Create or choose a directory on your hard disk for the Apple-
Turnover programs. Make this the active directory on the
hard disk.

Insert the Apple-Turnover program disk into Drive A.

Enter the command: COPY A:*.* C: to copy all the Apple-
Turnover programs from the program disk to your hard disk.

After the copy process is completed, store the original
program disk in a safe place.

NOTE

Default program options initially
are set for an IBM PC with two
floppy disk drives. Oun an IBM XT
or similar hard-disk computer,
you must change the program op-
tions for proper operation. Refer
to Section 4.1 for instructions.
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3
TUTORIAL

The Apple-Turnover programs share a common “user-

interface.” Learn

to use one program, and you have learned how to

use them all. Despite the similarity, there are still some important
differences between the various Apple-Turnover programs. There-
fore, this summary is organized as follows:

Sect. 3.1
Sect. 3.2
Sect. 3.3
Sect. 3.4
Sect. 3.5
The general

= below:

introductory material

general instructions for all programs

specific instructions for ATREAD and ATWRITE
specific instructions for ATINIT

specific instructions for ATSIFT

approach to using Apple-Turnover is summarized

PLAN ACTIVITIES Select the files to be copied from one disk

FORMAT DISKS

COPY FILES

MODIFY FILES

format to the other. Gather enough blank or
pre-formatted disks, and label them for easy
identification during your work.

Run the ATINIT program to format blank
disks for APPLEDOS or APPLE CP/M as
required.

AL : Y/ ! ) 5. Run
the ATWRITE program to copy files from
MS-DOS disks to APPLE disks.

Use the ATSIFT program (as needed) for
ASCII  text files that need minor
modifications.



3.1 Introduction

In the material that follows, a section of text is often devoted
to explaining a single menu screen. These sections will be headed
by a flow diagram or “roadmap” similar to the example shown in
Figure 3-1.

Present Available
Menu Choices Command
TITLE PAGE continue [F1]
Options Menu [F2]
Exit [F10]

Figure 3-1. Example of Program Roadmap

In Figure 3-1, The legend on the left (TITLE PAGE) identifies
the present menu or screen. The legends in the center column
(Format Menu, Options Menu, etc.) show possible selections for
next action. The right column shows the command required for
each selection. For example, to move from the TITLE PAGE to
the Options Menu, press function key [F2].

Menu selections and most other commands can be entered
using either of the methods described below:

1. FUNCTION KEYS

press a function key corresponding to the desired com-
mand. Each menu screen will display the active function
key selections in inverse video along the bottom of the
screen.

2. "ALPHA” KEYS

press a key (upper-case or lower-case) corresponding to the
first letter of the command name. For example, press the
key for the letter "Q” (or "q”) to execute the command
"QUIT.”
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Function-key commands and corresponding “alpha” key com-
mands are identical. This control setup enables you to program the
function keys for other tasks wusing a utility like Vertex’s
KEYSWAPPER while retaining control of Apple-Turnover through
the ”alpha” key commands.

All menus share a common basic screen layout. In this guide,
the screen menu is represented by the drawing shown in Figure 3-2.

SCREEN NAME Program Name

(central display area)

[F1] command [F2] command [F3] command [F10] Exit

Figure 3-2. Menu Screen Layout Example

All screens display the name of the current program or
program function in the upper right-hand corner. The current
screen or screen function is displayed in the upper left hand corner.
Function key selections are displayed along the bottom of the
screen. The lower central part of the screen usually displays
corresponding ”“Alpha” key commands.

3.2 Common Procedures

The following instructions apply to all Apple-Turnover
programs.

3.2.1 Startup

On floppy-disk based systems, insert your Apple-Turnover
work disk in Drive A and boot the computer. If your computer is
already at system level, be sure you see the "A” prompt on your
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screen.

On an IBM-XT or similar hard disk-based computer, boot
from the hard disk as vou normally would. Use the DOS "CD”
command to switch to the directory containing the Apple-Turnover
programs. Please note that the MS-DOS "PATH” capability is not

supported. All files will be copied to and from the same directory
that contains the Apple-Turnover programs.

Select the desired Apple-Turnover program by entering one of
the following commands:

ATWRITE [Enter] to copy files from an MS-DOS disk to

an APPLE disk

ATINIT [Enter] to format a blank disk in an APPLE
disk format

ATSIFT [Enter] to modify text files

After entering one of the commands listed above, the
corresponding program will load from disk and execute. After the
title page appears on your video display, you may remove your
Apple-Turnover work disk (for floppy-disk systems). Since the
program has been locaded into memory, the disk drive that
previously contained your Apple-Turnover work disk is now
available for copying files.

Most of the Apple-Turnover programs store default program
options in separate disk files. These files have an ".QPT” filetype or
suffix in the filename (e.g. ATREADDEF.OPT, etc.}. These default
options files must always reside on the same floppy disk, or in the
same subdirectory, as the other Apple-Turnover programs. If you
accidently try to run one of the programs without its companion
default options file, the program will cease execution and DOS will
display a “file not found” error.




3.2.2 Title Page Menu

Present Available
Menu Choices Command
TITLE PAGE APPLE Formats [Enter]
Options Menu [F2]
Exit [F10]

Figure 3-3. Title Page Roadmap

Each program presents a “title page” screen that displays the
program name, version, serial number and copyright notice. Take
one of the following actions:

e On floppy disk systems, press [Enter] to continue.

e On hard disk systems:

— press the letter “O” or function key [F1] to enter the
Options Menu.

— enter “"XT"” for type of host computer
— press function key [F1] to leave the Options Menu

Please refer to the Program Reference Section to learn how to
change program options, load and save modified default options
files, etc.

3.2.3 Select Apple Format

Present Available
Menu Choices Command
APPLE FORMATS APPLEDOS 1
APPLE CP/M 2
Options Menu [F3]
Exit [F10]

Figure 3-4. APPLE Disk Formats Roadmap
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Apple-Turnover supports APPLEDOS 3.3 and APPLE CP/M.
Computers that use the standard, unmodified 16-sector APPLEDOS
3.3 disk format should be compatible with Apple-Turnover.
APPLE CP/M disks must be compatible with the Microsoft
Softcard disk format.

Select the desired APPLE disk format from the menu. Type
the numeral ”"1” or “27 {Enter] to select the desired APPLE disk
format. Alternately, press function-key [F3] to exit from Apple
Formats Menu and enter the Options Menu. Press [F10] to Exit.

3.2.4 Exit Menu

Present Available
Menu Choices Command
EXIT run ATREAD [F2]

run ATWRITE [F3]

run ATINIT [Fd]

exit to DOS F10]

Figure 3-5. Exit Screen Roadmap

The Exit screen is similar to a road or highway that forks into
several different directions. You can exit from the current Apple-
Turnover program and return to DOS, or you can run one of the
other Apple-Turnover programs.

On floppy-disk systems, be sure to remove the current disk
from the active or default drive and re-insert the Apple-Turnover
work disk before making your command selection.

3.2.5 Error Handling

With a few exceptions, the Apple-Turnover programs manage
to trap most errors. Functionally, this means that you can correct
the problem and continue, instead of “crashing” the program and
starting all over again.

el

3-6



When a problem occurs, an “ERROR!” screen will appear
explaining the problem and offering several options for further
action. Please refer to Section 7 (Solving Problems) for additional
information about the ERROR! screen.

3.3 ATREAD/ATWRITE Procedures

The previous sections presented instructions for menus or pro-
cedures that apply to all programs. This section presents
instructions for the remaining ATREAD and ATWRITE menu

screens.

The ATREAD and ATWRITE are almost mirror images of
one another. The ATREAD program copies or transfers files from
an APPLE disk to an MS-DOS disk. The ATWRITE program is
virtually identical, but it transfers or copies files in the opposite
direction: MS-DOS to APPLE.

3.3.1 Insert Disks Menu

Present Available
Menu Choices Command
INSERT DISKS continue [F1]
APPLE Formats [F2]
Options Menu [F3]
Exit [F10]

Figure 3-6. Insert Disks Roadmap

After the desired APPLE format is selected, you are prompted
to insert the proper disk or disks in their respective drives. Please
read the instructions on the screen indicating the proper disk drive
for the “source” disk and “destination” disk.

The meaning of source and destination disk will change
depending on the program in use (ATREAD or ATWRITE). Please
note that files are always copied FROM the source disk TO the
destination disk. These designations will change depending on the
Apple-Turnover program in use.

3-7



Any available disk drive in your system can be the source disk
or the destination disk. Fach Apple-Turnover program has default
disk drive assignments that can be changed within the Options
Menu.

After inserting the proper disk in the correct drives, press
{Enter] or function key [F1} to read the catalog or directory of the
APPLE disk. You may, instead, return to the Format menu,
Options menu, or exit.

3.3.2 Select Files Menu

Present Available
Menu Choices Command
SELECT FILES pick files to copy

ask/copy files (#) [F1]
copy all files (*) [F2]
Newdisk [F3}
Options Menu [F4]
APPLE Formats [F5]
show MSDOS direct. [F6]
re-display screen [F7]
Exit [F10]

Figure 3-7. Select Files Roadmap

The “Select Files” screen is usually the center of activity. The
general approach to using the this screen is summarized below:

e view the APPLE disk catalog or directory, and (optionally)
the MS-DOS disk directory

@ select the desired files by type the filename, with or without
"wildcards”

@ copy the selected files from one disk to the other

@ repeat this process as desired
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e alternately, use the function keys to insert another disk,
change APPLE format, change the program options, exit to
another Apple-Turnover program, or exit back to MS-DOS

The following sections describe the most important aspects of using
the ”Select Files” screen.

3.3.2.1 Directory Displays

 After inserting the disks in the proper drives, the process of
reading the catalog or directory of the APPLE disk will begin. The
program will inform you of its progress by displaying the count of
the directory sector or record currently being read.

After-successfully reading the entire catalog or directory, the
contents of the APPLE disk will be displayed. Note the example
APPLEDOS catalog shown in Figure 3-8.

Sorted Catalog of APPLEDOS 3.3 Disk

CURVE FIT *A
HELLO *A
MAGIC T
PIX B
PLOT6A A
RIAMU MASTER *A
RIAVOL T
RIAXY MASTER *A
DOIT TO ME I

Figure 3-8. Apple-Turnover Display of an APPLEDOS Catalog

The filenames are sorted alphabetically for your convenience.
The code letter to the right of each filename shows the type of
APPLEDOS file. The code is displayed in Table 3-1.

When ATWRITE copies a file from an MS-DOS disk to an
APPLEDOS disk, you will be prompted to enter the filename and
the APPLEDOS file type. Please enter the byte value 0, 1, 2, or 4
as appropriate. Most of the time, the byte value 4 for text file will
be appropriate. Text files will have their “eighth bit” set
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Table 3-1. APPLESQOFT File Codes

CODE BYTE VALUE  FILE TYPE

A 0 APPLESCFT
1 1 integer Basic
T 2 Text

B 4 Binary

* + 128 locked

automatically as they are copied from MS-DOS to APPLEDOS.
Entering the wrong file type code may make the file unusable in the
APPLE computer.

APPLE CP/M directories are displayed in alphabetical order.
No additional information is displayed.

The directory of the MS-DOS disk can be displayed by
pressing function key [F6]. To recall the Apple directory, press
function-key [F7].

3.3.2.2 Selecting Files
There are four ways to select files:

1. press [Enter] to select the default filename (# unless changed
in Options Menu)

2. select a single file by entering the complete and accurate
filename

3. select several similar files by entering a generic filename using
"wildcards”

4.

The simplest (and least efficient) method for selecting a file to
copy involves typing the complete filename at the prompt. The

P

filename may be typed in upper-case or lower-case letters. Your ¢
input is converted to upper-case unless vou change one of the =
default options within the Options Menu.
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APPLE CP/M filename syntax is virtually identical to MS-
DOS. However, the syntax of APPLEDOS filenames is different
from the syntax used by MS-DOS and CP/M. If you are not
familiar with APPLEDOS and MS-DOS filename conventions, be
sure to read Section 5-1 before proceeding.

Select a similar class of files by using the four types of
wildcard characters supported by the Apple-Turnover programs.
These are listed in Table 3-2 below.

Table 3-2. Filename Wildcards

? represents any single character

* represents any combination of characters in
the filename or extension

! just like ”?” except the program will pause to
ask: (Yes/No) before copying

# just like ”*” except the program will pause to
ask: (Yes/No) before copying

The first two shown in Table 3-1 are the standard wildcards used
within MS-DOS and CP/M. The last two are additional
wildcards provided by Apple-Turnover to support “queried”
filename selection. Queried filename selection means that the
program will ask whether a file should be copied before it proceeds
to do so.

This leads to the two most common uses of filenames. Note
that function key [F1] selects ”“*.*” and function key [F2] selects
"#.#" as the desired filename. The ”*.*” selection will copy all the
files on a disk. It use is the same as it would be under MS-DOS or
CP/M. The "#.#" selection is just like "*.*” except that you will
be asked whether to copy each file.

Due to the vast differences between APPLEDOS and MS-DOS
filenames, selecting either ”"*” or “# ” will force you to rename each
file as it is copied. Make sure to enter a legal MS-DOS filename for
each APPLEDOS file copied.
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3.3.2.3 Copying the File

After selecting the desired files, ATREAD will begin the
process of copying the files from the APPLE disk to the MS-DOS
disk. The cumulative quantity of sectors or characters transferred
for each file will be displayed along the boitom of your screen.

For APPLEDOS, the sector count proceeds from sector 0, not
sector 1. Therefore, if your APPLEDQOS file consists 20 sectors,
then the file transfer will be completed at sector #19, not sector
#20.

With APPLEDOS, sclecting ™" {copy all files), or "#”
(queried copy of all files) automatically invokes the “rename” mode.
Each APPLEDOS filename will be displayed with a prompt
requesting the new MS-DOS filename. Please note the following
important guidelines:

e Most APPLEDOS filenames do not qualify as legal MS-DOS
filenames and must be renamed.

Pressing  [Eait 5 srallyy { #iThe truncated
APPLEDOS filename may contain spaces, punctuation, identi-
cal characters in the first 12 letters of the name, etc. that will
cause problems under MS-DOS.

Under APPLE CP/M, none of these difficulties exist because
MS-DOS and CP/M filenames are virtually identical in structure.

When ATWRITE copies files from MS-DOS to APPLEDOS
disks, there is an additional consideration. As shown in Table 3-1,
APPLEDOS 3.3 recognizes four different types of files. In an
APPLEDOS disk catalog, each file entry contains code indicating
file type.

When an MS-DOS file is copied to an APPLEDOS disk, the
ATWRITE program has no way of knowing the intended type of
APPLEDOS file. Therefore, you must enter a file type code for
cach file copied.
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The Select Files screen will prompt you to enter a file code
before the file copy begins. Enter the numeral "0” for ASCII text
files. Enter the numeral ”1” to indicate an APPLE Integer Basic
file (stored as integer basic tokens and strings, not converted to
ASCII). Enter the numeral "2” to indicate an APPLESOFT file
stored as tokens and strings. Finally, a “4” indicates an APPLE
6502 binary file. Please refer to Section 5 for additional informa-
tion and examples of APPLESOFT file codes.

As a note of warning, it is important to enter the correct file
type code. Otherwise, the file copied to your APPLEDOS disk may
not be directly usable in the APPLE computer.

3.3.2.4 NEWDISK Function

If you wish to substitute another APPLE disk for the one
currently in use, you must use the /NEWDISK” (function.
Exchange the disks. Then, press function key [F3]. The program
will display the “Insert Disks” screen.

Press [Enter] to continue. The APPLE disk catalog or direc-
tory will be read from the newly inserted disk. You will be
returned to the ”Select Files” screen and may proceed as desired.

3.3.2.5 Changing Apple Formats

Pressing function key [F5] enables you to change APPLE
disk formats with an automatic "NEWDISK” as well. After
pressing the function key, the ”Apple Formats” screen will be
displayed.

Select the desired APPLE disk format. The “Insert Disks”
screen is displayed. Insert the new disk in the proper disk drive.
Press [Enter] to read the new disks catalog or directory. You are
then returned to the ”“Select Files” screen.

3.4 ATINIT Procedures

The ATINIT program will format blank disks for APPLE
CP/M and initialize blank disks for APPLEDOS 3.3. The
initialization process for APPLEDOS disks will format the disk and
write a "HELLO” file. However, ATINIT does not write an
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APPLEDOS system onto the disk. Therefore, the resulting
APPLEDOS disk will not boot in an APPLE computer.

In a similar fashion, ATINIT does not write a CP/M system
onto a formatted disk. In both cases, this should cause no prob-
lems whatsoever. Use the disks as data disks. '

The material that follows discusses unique aspects of the
ATINIT program.

3.4.1 Insert Disks Menu

Present Available
Menu Choices Command
INSERT DISKS continue [Enter]
APPLE Formats [F2]
Options Menu [F3]
Exit [F10]

Figure 3-9. Insert Disks Roadmap

Place the blank disk to be initialized or formatted into the tar-
get disk drive. The target disk drive is displayed on the "INSERT
DISKS” screen. On a floppy-disk system, the default target drive is
Drive B. On an XT, the target disk drive is Drive A. The target
disk drive assignment can be changed from the Options Menu. As
a safety precaution, remove all disks from other floppy disk drives.

The initialization or formatting process is not particularly
rapid. It takes about two to three minutes to complete the
operation.

3.5 ATSIFT Procedures

The Apple-Turnover Sift program (ATSIFT) is a utility for
making minor modifications to text files. Minor changes to are
sometimes required to make APPLE text files usable in MS-DOS
applications and vice versa.
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ATSIFT can modify ASCII text files in the following ways:

1. convert Wordstar document files to standard ASCII text files
2. strip the ”high bit” from ASCII text files

3. remove a linefeed character after each carriage return charac-
ter

4. remove carriage return characters
5. remove the combined carriage return-linefeed characters
6. do simple search and replace functions

Please refer to Section 4 (Program Reference) for additional
information about these functions.

To run ATSIFT, type the command: ATSIFT [Enter]. When
prompted, type the name of the ASCII text file to be modified.
Then, type the name of the new file that will contain the modified
text. Do not use the same filename for both.

After entering the names of the original, source text file and
the new, modified text file, the main menu will be displayed. Select
the desired type of modification. Exit the program when
modifications have been completed.
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4
REFERENCE

4.1 Program Options

The Apple-Turnover programs can be modified to meet specific
needs through a system of user-selectable program options. The
following points summarize how the system works:

e Each program (except ATSIFT) uses several different global
options.

e Each program initially reads a set of default options from a
disk file. These default option settings remain in effect unless
changed.

e Individual option settings can be temporarily changed within
the Options Menu. Temporary changes can be saved in a disk
file and recalled when needed.

e You can modify or duplicate options files as desired. How-
ever, a default options file must be available for each
program.

4.1.1 Default Options Files

Your program disk contains files which store default options
for each program. Each Apple-Turnover program has a specific
default options file. The name of the default options file must not
be changed. Table 4-1 lists the default options file for each
program.

Table 4-1. Default Options Filenames

Program Default Options File
ATREAD ATRDEF.OPT
ATWRITE ATWDEF.OPT
ATINIT ATIDEF.OPT
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A properly named copy of each required option file must
always reside on your Apple-Turnover disk. If this file is not
available, then the Apple-Turnover program will abort displaying
the following DOS error message: “File not found ...”

If the default options file on your work disk is accidentally
erased or damaged, then it can be restored by copying the options
file from the original program disk.

Any operation involving program options takes place within
the Options Menu. This menu can be accessed from the program
title page and from most other program menus. The next section
describes the Options Menu screen and defines the program options.

4.1.2 The Options Menu

Present Available
Menu Choices Command
OPTIONS MENU change option
continue [F1]
Load New Options iF2]
Save New Options [F3]
Exit [F10]

Figure 4-1. Onptions Menu Roadmap

Within the Options Menu, the setting of individual program
options may be changed. Many settings are changed by typing a
Y7 {for "ves”} to activate the option, or "IN” (for "no”) to deacti-
vate the option. Others reguire a disk drive letter, number, or
filename.

Pressing the [Enter] key moves the cursor down to the next
row in the option column. You can use the up and down cursor
kevs to move the cursor along the options column. The backspace
kev will delete characters to the left of the cursor.

After making some changes, press function key [F1] to con-
tinue to the next program menu. In this instance, the modified
program options will remain in effect for the current session only.
The next time vou run the program, the default options will be back
in effect.
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If you want to use the modified options at some later date,
they can be saved to a file. Press function key [F3]. The program
will prompt: “Filename to write?” Enter the name of the new
options file and press [Enter], or just press [Enter] if you want the
changes to be saved to the default options file.

To load an alternate options file, press function key [F2]. The
program will prompt: “Filename to read?” Enter the name of the
desired file and press [Enter]. However, if a nonexistent or
incorrectly spelled filename is entered, the program will abort. DOS
will display a “File not found ...” error message. You will need to
restart the program.

Finally, press function key [F10] to leave the Options Menu
and go to the "Exit” screen.

4.1.2.1 ATREAD/ATWRITE Options
The following material describes the program options shown in Fig-
ure 4-2.

1. Which Machine (PC/XT)

The default value is "PC” which may be changed to "XT.”
This option sets internal program parameters. The "PC”
setting will work with a PC or XT. If your computer is
neither an IBM PC, XT or similar compatible, use the
default "PC” mode.

2. Which drive contains APPLE disk to read
— ATREAD

The source disk is an APPLE disk. The default set-
ting is Drive B (assuming a floppy-disk system). On
hard-disk systems (XT), change the source drive to
Drive A.

— ATWRITE

The source disk is an MS-DOS floppy or hard disk.
The default setting is Drive A (assuming a floppy-disk
system). On hard-disk systems (XT), change the
source drive to Drive C.
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OPTIONS ATREAD

Which Machine (PC/XT)

Which drive contains APPLE disk to read
Which drive contains MS-DOS disk to write
What is the default format number

What is the default filename

Display files on screen during transfer

Show record boundaries when files displayed
Suppress copying (view file only)

Change filename when copyed

Consider lower case same as upper case
Ignore rest of file after Ctrl-Z

Strip high bits in text files

How many retries on read error

RCZRZZZZ 3" P> WO

[F1] Continue  [F2] Load  [F3] Save  [F10] Exit

Figure 4-2. ATREAD Options Menu Screen

3. Which drive contains MS-DOS disk to write
— ATREAD

The destination disk is an MS-DOS floppy or hard
disk. The default setting is Drive A (assuming a
floppy-disk system). On hard-disk systems (XT),
change destination drive to Drive C.

— ATWRITE

The destination disk is an APPLE disk. The default
setting is Drive B (assuming a floppy-disk system).
On hard-disk systems (XT), change the destination
drive to Drive A.
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4. What is the default format number

Designates whether Apple-DOS 3.3 or Softcard CP/M is
the default format. In the